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Adding north arrows, scale bars, and other map 
elements 
 

 

 About adding map elements 

Some map elements are related to the data in data frames. North arrows, scale 
bars, scale text, and legends are examples of such elements. 

Learn about other map elements such as titles; graphic elements, pictures, and 
neatlines; reports; and graphs. 

 North arrows 

North arrows indicate the orientation of the map. 

 Scale bars 

Scale bars provide a visual indication of the size of features and distance between 
features on the map. A scale bar is a line or bar divided into parts and labeled with 
its ground length, usually in multiples of map units such as tens of kilometers or 
hundreds of miles. If the map is enlarged or reduced, the scale bar remains 
correct. 

When you add a scale bar to a map, the number and size of the divisions might 
not be exactly as you want them. For example, you might want to show four 
divisions rather than three or show 100 meters per division instead of 200. You 
might also want to change the units that the scale bar shows or adjust how those 
units are represented. You can adjust many characteristics of a scale bar from the 
Scale Bar Properties dialog box. 

When you add a scale bar to a map, the number labels and tick marks might not 
be exactly as you want them. For example, you might want to label the endpoints 
of the scale bar but not the divisions, or you might want larger tick marks at the 
major divisions of the bar than at the minor ones. 

 Scale text 

You can also represent the scale of your map with scale text. Scale text indicates 
the scale of the map and features on the map. Scale text tells a map reader how 
many ground units are represented by a map unit—for example, "one centimeter 
equals 100,000 meters". 

Scale text can also be an absolute ratio independent of units, such as 1:24,000. 
This means one unit on the map is equal to 24,000 of the same units on the 
ground. The advantage of absolute scale text is that map readers can interpret it 
with any units they want. 
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One drawback of scale text is that if a printed copy of the map is duplicated at 
another scale (enlarged or reduced), the scale text will be in error. Scale bars do 
not suffer this limitation. Many maps have both scale text and a scale bar to 
indicate the map scale. 

 Legends 

A legend tells a map reader the meaning of the symbols used to represent features 
on the map. Legends consist of examples of the symbols on the map with labels 
containing explanatory text. When you use a single symbol for the features in a 
layer, the layer is labeled with the layer's name in the legend. When you use 
multiple symbols to represent features in a single layer, the field you used to 
classify the features becomes a heading in the legend and each category is labeled 
with its value. 

Legends have patches that show examples of the map symbols. By default, the 
legend patches are points, straight lines, or rectangles that match the map 
symbols. You can customize the legend patches, for example, so areas are 
represented with patches of another shape or rivers are drawn with a sinuous 
rather than a straight line. 

Learn more about working with legend patch shapes 

 Frames 

Certain map elements—including scale bars, scale text, north arrows, legends, and 
data frames—can have frames. You can use frames to set map elements apart 
from other elements or from the background of the map. You can also use frames 
to visually link map elements to other parts of the map by using similar frames for 
related elements. 

 Converting map elements to graphics 

You might want to convert a map element, such as a legend, to graphics if you 
want more precise control over each item that comprises the map element. 

It is important to note that once you convert a map element into a graphic, it is no 
longer connected to its original data and will not respond to changes made to the 
map. For instance, with a legend element, if you decide to add another layer to the 
map after the legend has been converted to a graphic, the legend will not 
automatically update. It will have to be deleted and rebuilt again using the Legend 
wizard. Therefore, it is a good idea to convert elements to graphics only after your 
map, symbology, and so on, are finalized. 

The image below shows a legend that has been converted to a graphic. 
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You can further ungroup the legend graphics so the individual elements (the 
patches, text, and so on) that comprise the legend can be edited individually. 

 How to add map elements 

 Adding a North arrow 

1. Click the Insert menu and click North Arrow. 

2. Click a north arrow. 

3. Click OK. 

4. Click and drag the north arrow into place on your map. 

Optionally, resize the north arrow by clicking and dragging a selection handle. 

Tips 

Map elements aren't always the size you want when they're 
added to a map. You can change the size of map elements by 
selecting them and dragging the selection handles. Dragging a 
handle away from an element enlarges it, while dragging a 
handle toward an element reduces it. 

Each map element has a name used to identify the element. For 
example, when the layout is in draft mode, each element is 
drawn as a hollow frame containing the name of the element. By 
default, the name is based on the element type, such as Scale 
Line or North Arrow, but you can change it to a unique or more 
descriptive name on the Size and Position tab of the element's 
Properties dialog box. In addition, developers can take advantage 
of this name property to find and manipulate elements 
(IElementProperties::Name). 

A data frame's name property is always the same as what's 
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 Adding a scale bar 

1. Click the Insert menu and click Scale Bar. 

2. Click a scale bar. 

Optionally, click Properties to modify the scale bar's properties. 

3. Click OK. 

4. Click and drag the scale bar into place on your map. 

Optionally, resize the text on the scale bar by clicking and dragging a selection 
handle. 

 Customizing a scale bar's scale and units 

1. Right-click the scale bar and click Properties. 

2. Click the Scale and Units tab. 

3. Click the arrow buttons to set the number of divisions. 

4. Click the arrow buttons to set the number of subdivisions. 

5. Click the When resizing drop-down arrow and click how you want the scale bar 

shown in the table of contents. Therefore, updating the name 
inside the Data Frame Properties dialog box will also update its 
name in the table of contents. 

Tips 

Map elements aren't always the size you want when they're 
added to a map. You can change the size of map elements by 
selecting them and dragging the selection handles. Dragging a 
handle away from an element enlarges it, while dragging a 
handle toward an element reduces it. 

Each map element has a name used to identify the element. For 
example, when the layout is in draft mode, each element is 
drawn as a hollow frame containing the name of the element. By 
default, the name is based on the element type, such as Scale 
Line or North Arrow, but you can change it to a unique or more 
descriptive name on the Size and Position tab of the element's 
Properties dialog box. In addition, developers can take advantage 
of this name property to find and manipulate elements 
(IElementProperties::Name). 

A data frame's name property is always the same as what's 
shown in the table of contents. Therefore, updating the name 
inside the Data Frame Properties dialog box will also update its 
name in the table of contents. 
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to respond when the map scale changes. Adjust division value—the division 
value will vary with the map scale. The number of divisions and the width of 
the scale bar remain constant. Adjust number of divisions—the number of 
divisions will vary with the map scale. The division value and the width of the 
scale bar remain constant. Adjust width—the width of the scale bar will vary 
with the map scale. The division value and number of divisions remain 
constant. 

6. Choose the units for the scale bar. 

7. Click Symbol and choose a text style for the scale bar labels. 

8. Click OK.  

 Customizing a scale bar's numbers and marks 

1. Right-click the scale bar and click Properties. 

2. Click the Scale and Units tab. 

3. Click the Numbers Frequency drop-down arrow to choose where along the bar 
to place the numbers. 

4. Click the Numbers Position drop-down arrow to choose where to place 
numbers relative to the bar. 

5. Click the Marks Frequency drop-down arrow to choose where along the bar to 
place tick marks. 

6. Click the Marks Position drop-down arrow to choose where to place tick marks 
relative to the bar. 

7. Click the Division Height arrow buttons to increase or decrease the height of 
division tick marks. 

8. Click the Subdivision Height arrow buttons to increase or decrease the height 
of subdivision tick marks. 

9. Click OK.  

 Adding scale text 

1. Click the Insert menu and click Scale Text. 

Tips 

By default, the units label on a scale bar is the same as the scale 
bar units. Sometimes you might want to change the label of the 
scale bar, for example, from Kilometers to km. Just type the new 
scale bar label in the Label text box. 

You can only change the size, position, and frame of an element 
after it has been placed on the map. If you click Properties while 
inserting a map element, you won't see the Size and Position tab 
or the Frame tab.  
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2. Click a sample of the style of scale text to add to the map. 

Optionally, click Properties to customize the scale text. 

3. Click OK. 

4. Click and drag the scale text into position on your map. 

Optionally, set a specific font size for the scale text by choosing a font size 
from the font size drop-down list on the Draw toolbar. 

 Adding a legend 

1. Click the Insert menu and click Legend. 

The Legend wizard appears. If this wizard doesn't appear, wizards have been 
turned off. When wizards have been turned off, a default legend will be 
immediately added to your layout. You can double-click this legend to change 
its properties. If you'd prefer to use the Legend wizard when you insert a 
legend, you need to turn wizards back on. Click Options from the Tools menu 
and click the General tab on the dialog box that appears. Check the Show 
Wizards when available box. 

2. To remove a legend item, click it, and click the left arrow button. 

By default, all the layers on the map will appear as legend items in the legend. 

3. Use the Up and Down arrow buttons to order the legend items. 

4. Click Next. 

Tips 

Map elements aren't always the size you want when they're 
added to a map. You can change the size of map elements by 
selecting them and dragging the selection handles. Dragging a 
handle away from an element enlarges it, while dragging a 
handle toward an element reduces it. 

Each map element has a name used to identify the element. For 
example, when the layout is in draft mode, each element is 
drawn as a hollow frame containing the name of the element. By 
default, the name is based on the element type, such as Scale 
Line or North Arrow, but you can change it to a unique or more 
descriptive name on the Size and Position tab of the element's 
Properties dialog box. In addition, developers can take advantage 
of this name property to find and manipulate elements 
(IElementProperties::Name). 

A data frame's name property is always the same as what's 
shown in the table of contents. Therefore, updating the name 
inside the Data Frame Properties dialog box will also update its 
name in the table of contents. 
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5. Type a title for the legend. 

6. Set the text color, font, and size as desired, then click Next. 

7. Click the Border drop-down arrow and click a border. 

8. Click the Background drop-down arrow and click a background. 

9. Click the Drop Shadow drop-down arrow and click a drop shadow. 

10. Click Next. 

11. Click a legend item in the list to modify the symbol patch. 

12. Set the Patch properties as desired and click Next. 

13. Set the spacing between legend elements by typing a value into the 
appropriate box. 

14. Click Finish.  

Tips 

When you have more than one data frame, inserting a legend 
adds a legend for the selected data frame. Each legend 
corresponds to a single data frame, although you can arrange 
multiple legends together as a single legend for a complex map. 

You can edit the text of the labels that appear in the legend by 
changing the text in the ArcMap table of contents or on the 
Symbology tab of the Layer Properties dialog box. 

You can change the text symbol used by multiple legend items 
using the Items tab of the Legend Properties dialog box. You can 
change the text symbol of all the items in the legend or just the 
ones you have selected in the list. A drop-down list lets you 
choose the parts of the legend items to which you want the text 
symbol to apply. 

If you want an additional description of single symbol layers to 
appear in your legend, choose a legend item style that includes a 
description. To add a description, right-click the layer to which 
you want to add descriptive text in the table of contents, click 
Properties, add click the Symbology tab on the Layer Properties 
dialog box. If you are using the Single symbol method, click the 
Description button. If you are using a drawing method other than 
Charts, right-click a symbol after you have specified its 
symbology options and click Edit Description. The text you enter 
will appear next to that symbol in the legend; the text won't 
appear in the table of contents. 

If you want your description to be on more than one line, insert a 
line break by pressing the Ctrl and Enter keys together in the 
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 Changing the patches in a legend 

1. Right-click the legend on the map and click Properties. 

2. Click the Legend tab. 

3. Click the drop-down arrow to choose a new patch shape. 

4. Click OK.  

 Changing the patches in a legend that has transparent symbols 

If you know the opaque color values of your transparent symbols, you can 
start at step 5. 

1. Click Tools on the Main menu and click Customize. 

2. Click the Commands tab and click Page Layout. 

3. Click the Eye Dropper tool  from the Commands list and drag and drop it 
onto a toolbar, then close the Customize dialog box. 

4. Click the Eye Dropper tool  and click a polygon feature in the data frame. 

The Color dialog box displays the color name in Red, Green, Blue combination, 
and the displayed color is saved to the color palette. 

5. Click the Select Elements tool  in layout view. 

6. Right-click the legend and click Convert to Graphics. 

NOTE: The legend is now a graphic and is no longer linked to the data frame. 

7. Click Drawing on the Draw toolbar and click Ungroup. 

Repeat Ungroup until the legend patches and text are completely ungrouped. 

8. Click the legend patch you want to change. 

The patches are now simple graphics. 

Description for Legend dialog box. 

Legend text can be formatted using ESRI text formatting tags. 
See Using text formatting tags for more information.  

Tip 

If you have transparent symbols, you can have the patches in 
your legend display the opaque color values. However, you'll 
need to convert your legend to graphics, which removes its link 
to the data frame. See "Changing the patches in a legend that 
has transparent symbols".  
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9. Click the Fill Color button  on the Draw toolbar to open the color palette. 

10. Click the recently saved color in the color palette to apply it to the legend 
patch.  

 Changing the items in a legend 

1. Right-click the legend on the map and click Properties. 

2. Click the Items tab. 

3. Click a legend item in the Legend Items list. 

4. Click the up and down arrows to move the item up or down in the legend. 

Optionally, click Style and change the item's style in the legend, or check Place 
in new column to place the item in a new column, or change the number of 
columns for the selected legend item by clicking the up and down arrow keys, 
or remove an item from the legend by clicking it and clicking the left arrow 
key. 

5. Click OK.  

 Framing a map element 

1. Right-click the element on the map and click Properties. 

2. Click the Frame tab. 

3. Click the Border drop-down arrow and click a border. 

Tips 

Converting your legend to graphics removes its link to the data 
frame. 

Learn more about working with graphics 

Your colors don't need to be transparent to use the Eye Dropper 
tool; you can use it to identify and save any color on your map. 

Learn more about working with color 

Tip 

If you have two layers with the same geometry in a data frame—
for example, a layer of roads and a layer of streams—you can set 
their legend patches independently so that roads are shown with 
a straight line and rivers with a sinuous line. In the Legend Items 
list, click the item for the layer you want to change, right-click 
and click Properties, click the General tab and check the Override 
default patch box, then click the Patch drop-down arrow and click 
a new patch.  
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4. Click the Background drop-down arrow and click a background. 

5. Click the Drop Shadow drop-down arrow and click a drop shadow. 

6. Click OK.  

 Converting map elements to simple graphics 

1. Right-click an element and click Convert to Graphics. 

Remember that once you convert a map element into a graphic, it is no longer 
connected to its original data and therefore will not respond to changes made 
to the map. 

2. You can further ungroup the graphics by right-clicking the graphic and clicking 
Ungroup. Once ungrouped, the individual items that comprise the map 
element can be edited individually.  

Tips 

If you can't see the Frame tab, remember that you can only set 
the frame properties after an element has been placed on the 
map. 

If you group some elements together, you can right-click the 
group and set a frame for the group.  
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